# ZXWSOFT3.0 INSTRUCTION MANUAL

## Contents

1. Download and Unzip ................................................................. 3  
   1.1 Download .................................................................................. 3  
   1.2 Unzip ........................................................................................ 3  
   1.3 Run the ZXWSOFT master file in the unzipped folder ................. 3  
2. Software Registration and Dongle Binding .................................. 4  
   2.1 Run the ZXWSOFT master file ..................................................... 4  
   2.2 Register an account ................................................................. 4  
   2.3 User binding software with dongle .............................................. 4  
3. Contact and Working Hours ...................................................... 5  
4. Initial Purchase and Renewal ...................................................... 6  
5. Original Design Intention .......................................................... 6  
6. Basic Function .............................................................................. 6  
7. The Inner Circuit of the Board can be Lighted up ......................... 7  
8. Circuit Board Rotation, IC Bottom Pad Measurement Mode .......... 12  
   8.1 PCB Rotation Function (New): In order to coordinate the motherboard position in the maintenance table, the rotation function is specially opened .......... 12  
   8.2 IC test mode: ............................................................................. 13  
9. Part name and net name list Function .......................................... 15  
10. Part Parameters and the Replacement and Query Function of the Parts with same Parameters ......... 18  
11. Net Remarks ................................................................................ 22  
12. Component Physical map .......................................................... 23  
13. I2C Logic Analysis Function ....................................................... 27  
14. Open, Hide, and Close Functions on the Left and Right Toolbars .... 28  
15. Automatically Display NC (Shortcut N) ........................................ 32  
16. Automatically Display GND (Shortcut G) ..................................... 34  
17. Visible Reminder Function of pad Connecting Component .......... 38  
18. How to Change your Account or Exit the Automatic Login Status .... 39  
19. Display Part Name ....................................................................... 40  
20. Display Device pin name ............................................................. 42  
21. Component Tooltip .................................................................... 44  
22. Display Part Frame ....................................................................... 47  
23. View all pin .................................................................................. 48  
24. Highlight the pad on the Image ................................................... 51  
25. Vague Search and Connected Components of net Remarks ........... 52  
26. Color Matching Scheme and Color Configuration ...................... 54  
27. One key pass Function (shortcut P) .............................................. 59  
28. Switch A/B Side Function .......................................................... 61
<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>29</td>
<td>Refresh Function (shortcut F5)</td>
<td>63</td>
</tr>
<tr>
<td>30</td>
<td>Accurate Positioning pin Function</td>
<td>63</td>
</tr>
<tr>
<td>31</td>
<td>Automatically Show net Name</td>
<td>65</td>
</tr>
<tr>
<td>32</td>
<td>Refresh Menu</td>
<td>66</td>
</tr>
<tr>
<td>33</td>
<td>Choose Server/ Language</td>
<td>67</td>
</tr>
<tr>
<td>34</td>
<td>Cascade, Horizontal, Vertical of the Display Window</td>
<td>68</td>
</tr>
<tr>
<td>35</td>
<td>Expiry Date (Account Information)</td>
<td>70</td>
</tr>
<tr>
<td>36</td>
<td>Search File Function</td>
<td>70</td>
</tr>
<tr>
<td>37</td>
<td>Maintenance Case</td>
<td>72</td>
</tr>
<tr>
<td>38</td>
<td>Zoom in/ Zoom out</td>
<td>72</td>
</tr>
<tr>
<td>39</td>
<td>Automatically Show Diode Value</td>
<td>73</td>
</tr>
</tbody>
</table>
1. Download and Unzip

1.1 Download

Use IE or Google browser to enter the address http://zxwtools.com into ZXWT team website and click Software Download.

<table>
<thead>
<tr>
<th>No.</th>
<th>File Name</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>ZXWSoft3.0_MicroFish3.0_MiniPackage(23.5M)</td>
<td>2019-04-19上传</td>
</tr>
<tr>
<td>22</td>
<td>ZXWSoft3.0_MicroFish3.0_MiniPackage(23.5M)</td>
<td>2019-04-10上传</td>
</tr>
</tbody>
</table>

Choose website or Baidu Netdisk to download.

1.2 Unzip

After downloading the ZXWSOFT software compression package, you need to use the decompression software that supports the RAR format. Use the mouse to point the compression package and click the right button, and decompress it as follows. (It is not recommended to put the decompression file on the desktop)

1.3 Run the ZXWSOFT master file in the unzipped folder.

If the anti-virus software prompts ZXWSOFT to be a virus during decompression or running, you must choose permanent trust immediately. Otherwise, the ZXWSOFT process may be blacklisted after the countdown, and can only be run by reinstalling the PC system.
2. Software Registration and Dongle Binding

2.1 Run the ZXWSOFT master file

When running, there will be a small window to pop up. If you have an account, you can enter it directly. You can choose to log in automatically or remember your password.

2.2 Register an account

If you do not have an account, you can register an account and register quickly according to the process. You can also enter the password protection information and use it as a proof to retrieve the password when you forget your password. The information must be kept in mind. The software uses the user name and password to encrypt the data, and the password set by the user cannot be queried in the background. For the forgotten password and no security information entered, ZXWTeam cannot recover the password. You can only re-register the new account and purchase the corresponding time card for binding.

2.3 User binding software with dongle

After binding the account, the validity period of the dongle is transferred to the registered account, and the dongle is banned. This user cannot continue to use the lower version of the program that supports the dongle. After the 3.0 is released, the dongle renewal fee is no longer supported. After the dongle expires, it can still be bound to the account version, and the historical information will be associated with the new account.

Click the user information in the top left corner.
Click on *Binding Encryption dog*.

After binding, the dongle information will be associated with the account. The remaining service time is unchanged. Each account only supports one dongle binding. After binding, the dongle is invalid and cannot be restored. The expired dongle can also be bound to the account. The remark information and historical renewal information will also be associated with the account. In the future, there may be a priority to purchase the ZXW hardware product (the ZXW team has the final interpretation right).

**3. Contact and Working Hours**

Working time (break during national statutory holiday):
- Monday to Friday 9:30-12:00 a.m., 1:30-5:30 p.m.

Service QQ: 2546062320
Website: [http://www.zxwtools.com](http://www.zxwtools.com)
Phone: 0755-28716000
4. Initial Purchase and Renewal

ZXWSOFT3.0 or higher version does not use the dongle, you need to register the account to use. You can open the file without paying when it is a free file, if you need to use the paid file, you can click the Renewal Payment in the account information on the upper left, or contact the dealer to buy the digital password letter (authorization code). The renewal fee can be directly paid through the ZXWTEAM software payment platform, and can be used within 5 minutes after payment, without manual intervention.

5. Original Design Intention

Some engineers of ZXWTEAM came into contact with Chinese electronic maintenance industry in the early 1990s. They lacked circuit information in actual maintenance. Some mobile phones with schematic diagrams are not shown in physical condition on PCB, which has a great impact on the judgment of maintenance. In 2011, after several years of design, development and production, ZXWTEAM established the PCB bonding software for PCB maintenance. After eight years of positive development, the software has been upgraded to 3.0version, adding more novel and practical functions, and jointly pioneering with the maintenance industry! In 2019, ZXWTEAM will develop more innovative and practical functions!

6. Basic Function

Main board frame, pad, component bit number, etc. When you click on the pad, the corresponding bonding pad is lit. On the basis of basic functions, the new version of software adds more and stronger functions around PCB maintenance applications. Please continue to browse down for other functions!
7. The Inner Circuit of the Board can be Lighted up

As the difficulty of maintenance increases, many maintenance experts have found the safest and simplest way to repair the broken circuit between components and the components of the motherboard. One of the methods is the PCB inner layer routing method. This method has a great reliable advantage in disassembling risky components! The 2.6 version released in 2018 can display the inner layer of the motherboard. For technical reasons, the internal wiring can only be lit through the pad. Although there is great progress, it is still somewhat inconvenient. Therefore, the 3.0 version has developed the direct lighting function of any layer, which fills the blank of the maintenance industry and improves the maintenance efficiency!

The method of use is as follows: Open the model that requires maintenance test, the number of layers of the internal circuit will be indicated under the left model, and some models do not have the internal layer function. Check the corresponding internal circuits.

After checking:
The entire network and pad are lit after just clicking the internal circuit.

Because the circuit passes through the laser blind buried vias to all circuits, the blind buried vias of the circuit can be found after pressing F5. Light another end of the blind buried vias and judge the PCB layer where the circuit is located.

Laser blind buried vias connected between different layers.

After the blue circuit is lit
After the above operations, you can know the detailed route direction, which is convenient for engineers to repair various broken circuits faults.

A simple query method for surface circuits and pads:

For example, a screw hole is pierced by a long screw.
If the physical map is open, first close the physical map (shortcut T).

If you feel that the part name will block the circuit, turn off the View Part Name function on the right side.
Open the inner circuits you need on the left side.

At this time, the golden ring pad will block part of the circuits, so you can cancel the *View All Pin* function on the right side.

At this time, the surface annular copper foil has blocked on the circuit, so you need to click to cancel the *Surface net line* on the left menu to remove the occlusion.
Remove the pad and the surface line, the inner layer is unobstructed, and you can inquiry perfectly.
8. Circuit Board Rotation, IC Bottom Pad Measurement Mode

8.1 PCB Rotation Function (New): In order to coordinate the motherboard position in the maintenance table, the rotation function is specially opened.

The functions of these two icons are as follows:

- Rotate 90° to the right
- Rotate 180° to the right

First click 90° rotation to stand upright, then click 180° rotation, cooperating with each other to get the vertical position of the PCB.
In the horizontal state, you just need to press $180^\circ$ rotation once to get the horizontal position.

Through the above introduction, you can choose four kinds of PCB placements in an easy and convenient way.

8.2 IC test mode:

When you need to test the bottom pad of an IC or module (not a pad on the PCB),
For example, this power amplifier

You need to flip the chip.

Since the chip is flipped to the back side, the pins on the PCB will be opposite to the foot
pins of the pad bits in the following picture.

For this reason, ZXW has developed the measurement mode of IC bottom, the operation is as follows:

Select the shortcut icon at the top

Mirror function

180° flip of the mirrored document
The mirrored picture is as above, and the 1st and the 35th pins are interchanged to improve the accuracy of the foot pin of the bottom pad when testing the chip separately.

Back to Contents

9. Part name and net name list Function

After opening the corresponding file, if there is an option of Part Name and Net Name List, it means that this model has the relationship from pad to part.
Click Part Name and Net Name List, a dialog will pop up and you can move to the appropriate location.

Click on a pad that needs to be queried. After the pad is lit, the relevant connection components are displayed in the dialog box.
For example, by clicking on the IO pad of the SIM card holder, the right side shows that the IO pad connects the following devices.

Click on one of the connectors, such as DZ6905_RF-2. If the pad of the component is opposite to the PCB board (one-sided display), unlike the previous version of automatic switching, the software will select the PCB drawing to switch to the pad position of the opposite component. When using this function, buttons and shortcuts to find the pad connection on the current page are still valid.

This function makes the component connection of the pad clear at a glance. It is more convenient to reach the target pad and saves the time of discerning and thinking!
10. Part Parameters and the Replacement and Query Function of the Parts with same Parameters

Part BOM information related query: This function can query the detailed parameters of the components that ZXWSOFT has entered. The replacement and query of the parts with same parameters only supports resistors, capacitors and inductors for the time being.

Open the file that has this function:

Click Part BOM information related query on the left list, a dialog box appears:

When the mouse moves over the component, the parameters of the related component will be displayed in the dialog box.

If you want to find a missing or a damaged component, double-click the component. Let's take the 7P- R3301 as an example, first double-click the position of R3301:
At this time, the parameters of R3301 will always be displayed on the dialog box. When the mouse moves to other devices, the component parameters will be temporarily displayed, but the lower part of the dialog box has been locked to R3301. The parameters of R3301 are: resistance value 100K, accuracy 5%, power 1/32W, package 01005. Check the main parameters you want to query according to requirements. For example, if the circuit requires less precision, just select the resistance value and package.

Keyword:
- 100K
- 5%
- 1/32W
- MF
Filter:
- 01005

After clicking Search:

It queries 7 pages of data matching this resistance’s parameter.
Click on the pin name according to your personal situation (the motherboard that you can replace and disassemble).

For example, I have a 6P to dismantle, click R2341 of 6P, and software will ask you whether to open the 6P file, click YES.

And the 6P file is opened right now, we advise you to press T or display component physical map so that you can be more intuitive to see whether the selected components are installed at the factory.

Click on the 6P’s pin names of the same parameter in turn.
There will be a dialog icon that directly indicates where the component can be replaced.

<table>
<thead>
<tr>
<th>Part</th>
<th>Value</th>
<th>Type</th>
<th>Quantity</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>R2341</td>
<td>100K</td>
<td>5%</td>
<td>1/32K</td>
<td>MF</td>
</tr>
<tr>
<td>R2052</td>
<td>100K</td>
<td>1%</td>
<td>1/32K</td>
<td>MF</td>
</tr>
<tr>
<td>R1411</td>
<td>100K</td>
<td>5%</td>
<td>1/32K</td>
<td>MF</td>
</tr>
<tr>
<td>R1412</td>
<td>100K</td>
<td>5%</td>
<td>1/32K</td>
<td>MF</td>
</tr>
<tr>
<td>R1652</td>
<td>100K</td>
<td>5%</td>
<td>1/32K</td>
<td>MF</td>
</tr>
<tr>
<td>R1710</td>
<td>100K</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>R1401</td>
<td>100K</td>
<td>5%</td>
<td>1/32K</td>
<td>MF</td>
</tr>
<tr>
<td>R2004 RF</td>
<td>100K</td>
<td>1%</td>
<td>1/32K</td>
<td>MF</td>
</tr>
<tr>
<td>R3308 RF</td>
<td>100K</td>
<td>1%</td>
<td>1/32K</td>
<td>MF</td>
</tr>
</tbody>
</table>

Please note that the R1411 is not installed at the factory, so it is recommended to open the physical map of the component when using this function to avoid wasting unnecessary time.

For the loss or damage of components during maintenance, our software can quickly solve this problem with alternative components, which is the first in this industry. We help you save your time and make searching components easier.

Back to Contents
11. Net Remarks

Several components are connected together via a PCB and they belong to the same working network. This function does not need to be turned on manually, the system has automatically opened. Notice that some models do not have this function.

Open the corresponding model file and click on the pad.

In the lower left, there will be a Chinese explanation of the related network of the lighting pad.

The part name and pins are displayed in the following locations.

Click on the drop-down button of the component location, and all the components connected to the network will be displayed here.
Select any component, can directly reach the pins of related devices.

Back to Contents

12. Component Physical map

Component physical map function (shortcut T)

ZXWSOFT 3.0 version currently only shows the motherboard appearance and component pads.

When facing a single component pad, experienced engineers can accurately locate the target position, but the inexperienced junior and intermediate people need to think about
which component the pad belongs to.

Based on the above problems, ZXWSOFT has created a physical component map that can be attached to the motherboard pad components.

This feature shows the same physical component as the real motherboard, but it is not a scanned image, it has thousands of component images positioned on the associated pads.

Double-click on a physical component diagram, ZXWSOFT will display the main board pad as it is removed during maintenance, and we can query the connection relationship between the pad and other components by lighting.
After lightening the pad, the other connected pads are occluded by the physical drawings of the components, and the connection relationship will not be displayed, as shown in the following figure:

☑ Highlight the pad on the right menu, the connected components will be faded, and the pad will be displayed above the components. For engineers who are not familiar with the motherboard, they can accurately locate the components and more intuitively understand the components connected on the network.
The physical picture of the component can be hidden by double-clicking to hide the current device physical map. Since some physical objects will be larger than the outer frame of the component, when clicking the component image, you must click on the inner part of the component so that it can be recognized. The picture below shows the edge of the physical picture:

The effective area of the click is inside the pad border of the figure below. When using this function, try to click the center position of the component to improve the recognition rate.

Due to the complexity of the production process, only ZXWSOFT has developed this
function and open to users at present!

Back to Contents

13. I2C Logic Analysis Function

The I2C analysis software is only available to users during the software validity period, and users need to purchase a logic analyzer separately. Users whose account is not valid should not purchase hardware because ZXWTEAM does not provide a way to tell you how to operate the logic analyzer.

The user cannot use this function without logging in to the ZXWSOFT. After logging in, click the I2C icon.

And it will pop up ZXWSOFT USB Analyzer.
Using this software to analyze whether the communication of the bus external device on the corresponding model is normal, and the device bit number is used to judge whether the external device is damaged. Detailed usage functions are described in the instruction document for the logic analyzer.

Back to Contents

14. Open, Hide, and Close Functions on the Left and Right Toolbars

ZXWSOFT is divided into three control areas.
1. Top menu
2. Left side menu
3. Right side menu

★Right-click in a specific area

This unit only covers the closing, hiding, and opening functions of the right toolbar.
The left side will show different functions depending on the model you are selecting. If you need to hide, click the red triangle icon.

After closing the left side menu,
If you need to restore, click the red icon on the left side.

To hide the right toolbar, you also need to click the red icon.
Display the hidden right toolbar, click on the red icon.

There are two ☑ options below the right toolbar.

Select *Start to minimize*

When you open the software again, you need to click the red icon to release the right toolbar.
Select *Start to hide*

When you open the software again, the right side toolbar is no longer displayed.

If you need to display, follow these steps: Menu toolbar on the top → View → Right toolbar

Choose on the right side menu, the right side menu will be closed. After reopening the software, the right toolbar will restore the display.

**Back to Contents**

**15. Automatically Display NC (Shortcut N)**

Open the model you want to query.
All the pads on display are printed circuit boards, and the gold deposit layer is golden.

This feature can be turned on or off in the following four ways.
1. Right toolbar
2. Shortcut N

3. Top toolbar icon

4. Right-click to select *Hide and display component item*

The function of displaying the NC will be turned on according to the above four ways, and all the pads of the main board which are not connected to other circuits will display the preset blue color.

Hint: The blue pads are all empty pads, and there is no need to make up after the pads are detached.

The color of these NCs can be changed to other colors in the *Color Configuration* on the right side menu or by clicking the right mouse button.

Back to Contents

16. Automatically Display GND (Shortcut G)

*Automatically view GND* (shortcut G)

Open the model you want to query.
All the pads on display are printed circuit boards, and the gold deposit layer is golden.

Selecting this feature can be turned on or off in the following three ways.

1. Right side toolbar

- Auto view NC(N)
- Auto view GND(G)
- Diode value
2. Shortcut G

3. Upper toolbar [GND] icon

After opening the function of displaying GND in the above three ways, all the GND terminals of the main board (before installing the components) will be displayed in gray of physical solder.

The color of these GNDs can be changed to other colors in the Color Configuration on the right side toolbar or by clicking the right mouse button.
The color can be selected according to the preset configuration, or you can design the color as you like.

After choosing colors, click Save to save your settings.
17. Visible Reminder Function of pad Connecting Component

After lighting up the network, the background color of the components is highlighted displayed.
When the pad is lighted, the related devices and pads will be lighted at the same time to facilitate users to view the overall components.

You can change the color in Color Configuration on the right side menu, or you can choose the flashing function.

In order to view the circuits more easily, press F1 to switch on/off when it prompts you need to turn off the color/ flashing.

Back to Contents
18. How to Change your Account or Exit the Automatic Login Status

When the user chooses *automatically log in*, the software will enter the login state each time. If you want to change the account, please click on the left menu bar, and you can see the *account information* above the Help Center.

After clicking the button, there will be a *Cancel Auto Login* option. After canceling, close the ZXW3.0.

You can login with other accounts if you restart the software.
19. Display Part Name

View part name (location code)  Shortcut: Q

A motherboard consists of a number of soldered components, each component has the location number defined by the designer, and there is no repetition. The following describes how to turn on the ZXWSOFT’s bit number.

1. Upper left menu → View → Show/hidden part name

2. Shortcut on the top menu

3. Right side toolbar

4. Right click
When the part name function is opened, the motherboard displays the part number at design or production in a separate component.

Before opening:

After opening:
While using the convenience of the part name, the location information also blocks some pads to varying degrees, so we have designed several options to turn on/off the function. Users can choose to show/hide the part names according to their personal habits.

Back to Contents

20. Display Device pin name

A component has multiple pins, and the number of the pins owned by the individual components is called the pin name.

There are 4 ways to turn on this function.
1. Find it in the upper toolbar → View
2. Shortcut on the top menu

3. Right toolbar

4. Right click
Select the pad of the element, the welding pads without pin numbers are as follows:

After displaying the pad pin number:

Note: The components, resistors, capacitors of the two pins, pin1 and pin2 do not participate in the ZWX pin mark; if displayed, pin1 and pin2 may not be the same as the one marked on the schematic, but the overall circuit (connection relationship) is not affected.

Back to Contents

21. Component Tooltip

Component prompt function (some models):
When the mouse points to a device or when you click on a pad, if the device or pad has been marked/ set by ZWX, the BOM information or measurement parameters of the device will appear (the above functions are subject to actual conditions).

How to turn on the function:
1. Find it in the upper toolbar→ View → Show/ Hide NO. → Show/ Hide tool tip
2. Right toolbar→ component tooltip

Before it is turned on, when the mouse moves over the component, there is no prompt.

Click the pad, there is no net remark or other measurement data.
After selecting

![Component tooltip]

After clicking on the pad, net remarks and test data are displayed on the lower left bar.

| Net remarks: 前摄像头DVDD电压1V2连接器插口（J_4303） ※ 端板未拆件（铰链含0.598） |
| PartName: C2903 | C2903-1 | PP1V2_NH_DVDD_CONN |

Note: Some models may not have any prompt information, please use it according to the actual display results primarily!
22. Display Part Frame

Part frame (shortcut F)
For components with multiple pins, ZXW will make a separate package for all pins belonging to this component, which can show the independent external frame of the component, so that users can more clearly determine the assignment of the pad pins.

There are 3 ways to turn on/off this function:
1. Upper toolbar→View→Show/Hide part→Show/Hide frame

2. Shortcut F

3. Right toolbar

Before clicking Part frame (F), the motherboard device has no frame and requires users themselves to determine which device the pad belongs to.
After clicking the pad display a separate component frame in the form of ZXW editing.

Note: Some models do not provide component frame function for technical reasons. Please refer to actual usage results.

23. View all pin

This function can hide all the pads in the surface layer, and the purpose of hiding the pads is not to block the internal alignment; the membership relationship is pad- surface traces- internal multi-layer traces.

Turn on/ off is on the right toolbar
Turn on **View all pin**

Part of the surface net lines will be displayed after all pads are closed.

You can close the surface net line on the left toolbar.
After closing the surface net line, the motherboard only presents the appearance.

After opening the surface net line:

- Surface net line
  - To A inner (1) layer

The final connection relationship of the internal lines can be judged by coordinating with View all pin.
24. Highlight the pad on the Image

When the physical drawing of the component is turned on, the pad is lighted, and the other pads will not be displayed if they are covered by images; when this function is turned on, the connected pads will be displayed on the component image.

There are 2 ways to turn on it.
1. Upper menu → View → Show/Hide Part Image → Light PIN up to image
2. Right toolbar
25. Vague Search and Connected Components of net Remarks

The network can be searched by the keyword. After selecting the network, the connected devices on the network can be queried.

This function is not set to turn on or off, it is shown in the network dialog at the bottom.

Enter the keywords you want to query in the Network Name window. Press Enter after entering, and the networks containing the keywords will appear in the dialog box.
Without clearing the network name and clicking on other pads, the results of the vague query will continue to appear after the next click.

Choose a network.

Click on the button in front of the network name.

All the components connected to this network will appear in this box. Click on one of the components to reach the motherboard directly.

Back to Contents
26. Color Matching Scheme and Color Configuration

Color Configuration

ZXW provides modification of most of the colors except for the gold-plated solder pads on the motherboard, and supports personalized color matching.

There are 2 ways to open it.
1. right-side shortcut bar

2. Right click

This function can change the following display colors.
1. Baseboard color
2. Click color

3. Network line color (set the surface line to be green)

4. Line lighting color (the color after the surface circuit is lit, for example, set to dark blue)

5. Locating hole color (laser blind buried hole of the line to other layers)
6. Pin name color (pin text displayed in the pad)

<table>
<thead>
<tr>
<th>PinName color :</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="PinName Color" /></td>
</tr>
</tbody>
</table>

7. Part name color (part location code)

<table>
<thead>
<tr>
<th>PartName color :</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2" alt="PartName Color" /></td>
</tr>
</tbody>
</table>

8. GND color (GND port)

<table>
<thead>
<tr>
<th>GND color :</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="GND Color" /></td>
</tr>
</tbody>
</table>
9. NC color (empty pad not connected to any circuit)

10. Custom remark line (Remarks related to information)

11. Custom remark color (Remarks related to information)

12. Part Location Point (Orientation of component installation)

13. Inner Line Color (internal multi-layer circuit setting)

14. Color preset scheme
(Preset 2 kinds of base plate colors)
To change the above colors, the following actions are required:
1. Click the preset color, and it will pop up a window

![Color preset scheme: option](image)

Click: Initialize the color, the background color is green

![Color preset scheme: color options](image)
2. And click this one (customize colors)

First click to decide the general color, then drag the arrow icon on the right side to decide the final color.

After deciding you color, click and the custom color will be added to the left area.

Click the color you customized just now, and click , the relevant location has been configured to a custom color.

All of the above settings need to click icon to take effect.

27. One key pass Function (shortcut P)

In the process of repairing or making a repair case, it is necessary to deal with the highlighting reminder or ignore the target mark.

Select a pad (a network)
Press P to highlight the pad, and the pad will disappear.

After highlighting the pad, you need to change other colors.

Click the icon on the top tool bar and chooses green color.

For example, repair this chip circuit, you press P to hide when the pad is tested normal, and if there are problems, you need to change the color to remind yourself to focus on the inspection; if you need to halt during the middle of the maintenance or do other works, you can save the test results first.

Enter in the dialog box.
After saving, you can find it when you use it next time. Select the one you saved last time.

It still remains the state of previous measurement.

This function can be used for many purposes, such as lightweight maintenance, case making, test mode, etc.

28. Switch A/B Side Function

There are two ways to turn on this function.
1. Shortcut: Tab
2. Right-side shortcut bar
Switch AB (Tab)
One key pass [P]
Empty remark

Back to Contents
29. Refresh Function (shortcut F5)

Press F5 or click on the right-side shortcut bar.

Most of the states such as click, query, selection, drawing notes, etc. can be removed and restored to the initial state.

If you need to clean up the drawing remarks, you need to click the button on the right toolbar.

30. Accurate Positioning pin Function

Precisely locate to the pins which are specified by complex chips.
Enter the part name in the dialog box, the format is part name- pin name, e.g. U0700-CG20

Click to inquiry.

If the input is correct, there will be a prompt icon (shown as the above picture). At this time, the pad position is only indicated but not lit. If you need to light up, view the network relationship or other information, you need to light the pad manually.

If you want to cancel this prompt icon, remember NOT TO CLICK the on the icon, you can double-click in an empty position or press F5 to refresh.

Back to Contents
31. Automatically Show net Name

Automatically show net name on the pad:

In ZXWSOFT, each pad belongs to a preset network. Its network name is generally a function description on this circuit. It is marked in English. Some models ZWX have already done Chinese translation, but for experienced maintenance personnel, reading English is more convenient and quicker. For this reason, ZWX has opened the pad Network Name function. When the pad is enlarged to a certain range, the network name will be displayed on the pad, which is convenient for quick reference and judgment during the maintenance process.

If they are blocked by part names when you are using our software,
Please press shortcut Q to close or click Show Part Name.

32. Refresh Menu

If there is a problem with the software, or if some models are missing from the file list (compared with other users), try updating the menu.

Click Settings→Refresh menu file
And it will pop up a window and prompt the update is successful.

Click and the software will exit automatically, and all you have to do is to restart the software.

33. Choose Server/ Language

Choose a suitable server, ZXW provides China Telecom, China Unicom for China mainland users and also Hong Kong servers for global users.

If you do not choose, the software will automatically choose a usable server. If the effect is
not good, please manually switch to a server that suits you.

Selecting Language
ZXW provides multiple languages for global users.

Please select it according to your actual usage state.

34. Cascade, Horizontal, Vertical of the Display Window

This function can be used from the top toolbar→Window.

Click Cascade.
Click **Horizontal**.

Click **Vertical**.
※Users without a mouse can use the following way: Press ALT and release, then press W, and you will see the following image ↓, choose the function you want.※

![Image of window options]

35. Expiry Date (Account Information)

Click the account information at the upper left can see the expiry date of your account.

![Dear,]

- Expiry Date: October 17, 2019
- Renewal payment
- Account Settings

In the account settings, you can check and modify information.

36. Search File Function

Search file function (shortcut: Ctrl+F)
There are 3 ways to turn on this function.
1. Upper toolbar → View → Search File

![Search File toolbar]

2. Shortcut Ctrl+F
3. The icon on the upper toolbar.
And you will see the searching interface.

Type the **keyword** of the model, such as 7P.

Double-click the result, and it will open the corresponding model.
37. Maintenance Case

In ZXWSOFT 3.0 version, if the dongle is bound, the information in the previous dongle will be automatically transferred to the bound account. If you want to publish the case in the ZXW maintenance case, please send the case to our Wechat: ZXWTEAM, or send the document to this mailbox: ZXWideasbox@126.com. ZXWTEAM will upload the case to ZXWSOFT and put authors’ names on it.

38. Zoom in/ Zoom out

There are 3 ways to zoom in/ out the motherboard pad.
1. Scroll wheel. Scroll up to zoom in, scroll down to zoom out.
2. Icons on the top toolbar.
3. Right click (for notebooks that work with touchpads)
39. Automatically Show Diode Value

Turn on/off on the right side toolbar.

When you select this function, if the current file has the measured ‘resistance’ (diode voltage drop) or other parameters, zoom in the pad and you can see it. Besides, you can click the Part BOM Information Related Query to check for more parameters.